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INTERMEDIATE WORD

FORMATTING DOCUMENTS

1 OF 9 (1-2 CHARACTER EFFECTS)

Word allows you to apply text formatting to different items of text.  You have a range of possible character formats and characteristics that you can apply to the text in your documents.  This range helps you to create personalized and professional looking documents.  You can select formatting and characteristics that you want to apply before typing the text that you want it to apply to.  Or you can select specific text and then choose the formatting that you want to apply to it.  Let's say that you are formatting the text in a report you have written.  You want the paragraph headings to have the shadow effect and to be in small capital letters.  You also want to apply subscript character effects to a product name.  To apply character effects, you first select the text that you want to apply the effects to.  You then select Format - Font.  And the Font dialog box displays.  The Font tabbed page is the default but if you have used one of the other tabbed pages previously, that tabbed page will open first. You then click the Font tab to open the page.  To apply the shadow and small capital effects, you select the Shadow and the Small caps checkboxes and you click OK.  The changes are then applied to the text you have selected.  To view the effects properly, you deselect the text.  To add the subscript effect to a product name, you first select the text.  Then you select the Format menu.  And you select the Font option.  In the Font dialog box you select the Subscript checkbox and click OK.  And the subscript effect is applied.

2 OF 9

Let's say that you want to transfer the text effects that you have applied to the Introduction title to the other titles within your report.  The quickest way to do this is to use the Format Painter.  The Format Painter copies text formatting and applies it to any text that you specify.  If you don't see the Format Painter button on your toolbar, you can add the button to it.  To access the Format Painter, you click the More Buttons button on the Standard toolbar.  You select the Format Painter button from the Add or Remove Buttons drop-down menu.  And the Format Painter button is added to the toolbar.

To use the Format Painter, you first position the insertion point in the text whose format you want to apply elsewhere.  Then you click the Format Painter button, and the mouse pointer changes into a graphic of a brush.  To transfer text effects to the next paragraph heading - in this case the Current strategy title - you scroll down to the text.  And, using your mouse, you select the text you want to change.  The text changes once it is selected and the Format Painter is automatically deselected.  To keep the Format Painter active for more than one text item change, you ensure the cursor is positioned within the text that has the formatting that you want to copy and double-click the Format Painter button.  You then scroll down to the next text item and you select it using your mouse.  If the Format Painter button has been double-clicked, it does not automatically deactivate after a text change.  You can continue to apply it to other text items until you deselect it.  To deactivate the Format Painter, you click the Format Painter button or you press the Esc key.  You can then continue modifying your text.

3 OF 9 (3-5 STYLES)

A style in Word is a set of formatting characteristics that can be applied to a particular piece of text.  These include header styles, message box styles, and paragraph styles.  Using a style to format text allows you to apply a range of formatting characteristics in one task instead of having to apply the characteristics separately.  Word has several predefined styles from which you can choose - for example Normal style.  It is also possible to create new styles or to modify existing styles according to your needs.  You can apply styles by selecting them from the Style drop-down menu.  The drop-down menu displays a subset of available styles that updates with the styles that you use in your document.  Each style title is formatted with its own style so you can see what the style looks like.  To preview styles or view styles not available in the Style drop-down list, you select Format - Style.  The Style dialog box that displays has a range of styles that you can preview.  You can change the list of styles displayed using the List drop-down list.  The Paragraph preview section displays the alignment, spacing, and other paragraph characteristics of the style that you have selected.  And the Character preview section displays the font characteristics of the selected style.  You can use the Style dialog box to copy individual styles from the current document to its template.  This makes the styles available to all new documents using that template.  To copy a style to a template, you click the Organizer button.  In the Organizer dialog box you can select the styles, AutoText, toolbars, and macro project items that you want to be available in a particular document or template.  The New button in the Style dialog box allows you to create new styles and add them to the template if required.  The Modify button allows you to modify existing styles.  And the Delete button allows you to delete particular styles.  The Apply button in the Style dialog box allows you to apply a particular style and to close the dialog box.  And the Cancel button allows you to close the dialog box without applying any changes.
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Let's say that you want to apply the Document Map style to a paragraph heading in your document.  And suppose that this style is not immediately available from the Style drop-down list on your toolbar.  To apply a style to a paragraph or a paragraph heading, you first select the text that you want to change, in this case it's simply the Introduction heading, and then select Format - Style.  You then choose a style from the Styles list - in this case Document Map.  And to apply the style, you click the Apply button.  Let's say that you want to change the Document Map style so that the text is embossed, the heading is centered, and the spacing after the style is slightly larger.  There are two ways of modifying existing styles.  You can set Word to automatically update styles while you are working on a document.  Or you can apply format changes within the Style dialog box that are then transferred to the paragraph or text in your document.  When modifying a style, you first need to ensure that your insertion point is positioned within the text whose style you want to change.  Then you select Format - Style.  And in the Style dialog box you click the Modify button.  To set Word to automatically modify a style as you work on part of a document that it is being applied to, you select the Automatically update checkbox and return to the document.  And to modify a style that will be applied to your heading later, you click the Format button.  To change, for example, the font in the Document Map style, you select Font from the Format pop-up menu.  On the Font tabbed page you select the style changes you want to make - in this case you select the Emboss checkbox - and click OK.  To make changes to the Document Map style's paragraph layout, you select Format - Paragraph.  In this case you change the alignment to centered by selecting the Centered option in the Alignment drop-down list.  And, to increase the spacing after the style, you click the up-pointing arrow on the After spin box and click OK.  If you want to add the modified style to the template, you select the Add to template checkbox.  To keep your changes and return to the Style dialog box, you click OK.  Then to implement the changes and return to the document, you click the Apply button in the Style dialog box.  The text in your document is then displayed with its modified style.
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You can create a new style in Word and add it to your list of styles.  This allows you to create styles unique to your organization and to ensure that your organization's document styles are consistent.  You can approach creating a new style in two ways.  You can first set character and paragraph layout in a document and then base a style on it.  Or you can create a style first and then apply it to text and paragraphs.  Let's say you want to create a style from the formatting you applied to your paragraph heading that can be applied to other paragraphs in a single step.  To do this, you place the insertion point anywhere in the text and select Format - Style.  You then click the New button.  In the New Style dialog box you type the name of the style - in this case Subtitle1 - and choose Paragraph from the Style type drop-down list.  If you want a style to apply to selected characters and not whole paragraphs, you select Character from the Style type drop-down list.  To save the changes and close the New Style dialog box, you click OK.  And to apply the changes and to return to the document, you click Close.  Once you have created a new style in a document, it appears in the Style drop-down list on your toolbar.  Suppose that you want to create a new style before applying it to text.  You want to name your new style Message1 and you want to change the text format to Times New Roman 10pt bold that has the shadow effect applied.  You also want Normal style to be automatically selected after you have typed a paragraph in the Message1 style.  To create a new style before applying it to text, you select Format - Style.  You then click the New button in the Style dialog box.  And the New Style dialog box is displayed.  You type Message1 in the Name text box and select Normal from the Style for following paragraph drop-down list.  To choose the text characteristics of your new style, you select Font from the Format pop-up menu.  After selecting the changes, you click OK.  To close the New Style dialog box without losing your changes, you click OK.  If you have text selected to apply this new style to, you do so now by clicking Apply otherwise you click Close.  And the Message1 style is ready to be applied in your document.  You can apply a new style that you have created to other paragraphs in your document.  To do this, you place the insertion point at the start of the paragraph that you want to change.  And you select Message1 from the Style drop-down list.  Selecting a paragraph style from the Style drop-down list automatically converts the following paragraph to the style that you have chosen.  

6 OF 9 (6-9 THEMES)  

Word 2000 allows you to apply design themes to your documents.  A theme is made up of a group of default settings that are applied to all the elements of your document to give it a professional, unified appearance.  A theme customizes the background, hyperlink, and table border colors of your document.  And it customizes the heading style, body text style, bullet style, and the horizontal line style.  A theme is not the same thing as a document template.  A template provides AutoText entries, custom toolbars, macros, and other document formatting tools.  But a theme is a formatting option that is applied to your document's appearance.  You can add, change, and remove themes in a normal Word document or a web page.  You can also preview themes before they are applied.  Word themes are installed on your hard disk when you install Word 2000 but you can also use the themes from FrontPage versions 4.0 or later or you can download additional themes from the Internet.
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Suppose that you want to create a new document and apply a theme to it.  To open a new Word document, you select File - New.  You can then create a new blank document and select Format - Theme or you can use the Web Page Wizard to create a document with a theme.  To use the Web Page Wizard, you click the Web Pages tab.  Then you double-click the Web Page Wizard option on the Web Pages tabbed page.  In the Web Page Wizard dialog box you are prompted to choose a theme for your web page.  To choose a theme, you click Browse Themes.  If you do not want a theme to be applied to your web page, you select the No visual theme radio button.  When you select a theme from the list provided, the theme settings are displayed in the preview section.  You select a theme, in this case Sumi Painting 3, and you click OK.  When you have completed the settings in the Web Page Wizard dialog box, you click Finish.  And the theme you have chosen is applied to the new document.

8 OF 9

Let's say that you want to apply a theme to a document or a web page and you want it to act as the default theme when you create documents in the future.  To create a default theme in a document or web page, you first open the document.  Then you select Format - Theme.  And you select the theme you want, in this case Sumi Painting 3, from the Choose a Theme list.  When you have selected the theme you want to apply to the document or web page, you click the Set Default button.  And you click Yes in the Set Default Themes dialog box.  The theme you have selected is now the default and will be applied to all future documents.  If you set a default theme for a web page using the Format - Themes option, the default theme is applied only to the current web page.If you want to apply the theme to the entire web site, you need to use the Web Page Wizard.  For business purposes you may want to set your document up as a fax, a memorandum, or other business document.  If this is the case, you click the Style Gallery button.  Then you select the document style you want to apply, in this case Elegant Report, and you click OK.  The business document style is applied to your document along with the theme you have chosen.
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Themes can be applied to e-mail messages created using Word.  If you create a document in Word and then want to send it to someone using e-mail, you select File - Send To - Mail Recipient.  And Microsoft Outlook opens so that you can enter the recipient's e-mail address.  If you want to apply a theme to an e-mail message written in Word, you select the Tools menu.  And you select Options.  In the Options dialog box you click the General tab if you want to apply a theme to your e-mail document.  On the General tabbed page of the Options dialog box you click the E-mail Options button.  Then on the Personal Stationery tabbed page you click Theme.  From the Choose a Theme list you select the theme you want to apply to the e-mail message, in this case Sumi Painting 3.  And you click OK.  Then you click OK on the Personal Stationery tabbed page to apply the theme.  When you have completed all the settings for your theme, you click OK.  Then you click Send a Copy to send the e-mail message.  The theme is applied to the e-mail message and will only appear on the recipient's copy.

END OF FORMATTING DOCUMENTS

SUMMARY:

You have seen how to format documents in Word 2000.  

You can change the look of your text in Word by applying different character effects. And if you want to transfer character effects and text formatting from one text item to another, this can be done quickly and easily using the Format Painter.  A style in Word refers to a set of formatting characteristics that can be applied to particular text items. You can apply a variety of styles to a document from a list provided by Word or you can create new styles to meet your needs. Pre-existing styles and custom-built styles can be modified and updated in a variety of ways both from within the text and from within the Style dialog box.  Word 2000 allows you to apply design themes to your documents. A theme is made up of a group of default settings that are applied to all the elements of your document to give it a professional, unified appearance.  You can add, change, and remove themes in a normal Word document or a web page. And you can create default themes for documents, web pages, and e-mail messages.

UNIT TEST:

1. You can specify the character formatting to be applied to text immediately before you type it.

a. True

b. False

2. To get the Format Painter to apply text formatting to one item of text and then automatically turn off, you _____ the Format Painter button and to apply text formatting to more than one item without reactivating the Format Painter, you _____ the Format Painter button.

a. double-click

b. click

3. Which of the following statements about styles in Word are true?

a. A style is a template that prompts for particular content in a document

b. A style refers to character formatting as opposed to paragraph formatting

c. A style refers to paragraph formatting as opposed to character formatting

d. A style is a set of formatting characteristics that can be applied to a particular piece of text

4. Which of the following are true of styles in Word?

a. There are a range of predefined styles available in Word

b. Predefined styles in Word cannot be modified

c. You can create and save new styles in Word

d. You can modify a style as you change text formatting in your document if you have activated the automatic update feature

5. Which of the following do themes add to documents?

a. Customized colors in the background and tables

b. Custom text styles

c. Formatted horizontal lines

d. Custom toolbars

6. To which of the following can you apply themes in Word?

a. FrontPage documents

b. E-mail messages

c. Excel documents

d. Web pages

7. From which of the following can themes be imported into Word?

a. FrontPage 2000

b. The Office web site

c. PowerPoint 2000

d. Outlook 2000

8. You use the Web Page Wizard to set a default theme for an entire _____.

a. Word document

b. web site

c. e-mail message

9. Is the following statement true of false?

If you apply a default theme to one e-mail message, any new messages you create after that will have the same theme applied to them.

a. True

b. False

ANSWERS:

1. True

2. 1st blank: click, 2nd blank: double-click

3. d

4. a, c & d

5. a, b & c

6. a, b & d

7. a & b***

8. b

9. True

INTERMEDIATE WORD

COLUMNS

1 OF 5 (1-3 USING COLUMNS)

Word document text is formatted by default in a single column.  But Word allows you to format your document text in multiple columns.  This means that you can publish a document as a newsletter or brochure.  You can use the Presets section of the Columns dialog box to create predetermined numbers of equal or unequal columns in your document.  Or you can use the Width and Spacing section to manually create columns of varying widths.  You can also determine the number of columns you want using the Number of columns spin box and you can choose the Line between checkbox to place lines between them.  The columns can be applied to the whole document or a selected section.But you need to select a section before applying the column structure if you want to apply it to only a portion of the document.  When you arrange text in multiple columns, you can edit, move, and modify it in the same way as you do text in single columns.  You can also remove the multiple column formatting at any time.  You can use section breaks in a Word document to divide it into parts.  This allows you to apply different formats to different parts of the same document.  So, for example, you can use one column in part of a document and use multiple columns in another part.
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Let's say that you decide to use the Progress Report document as part of a brochure about your company and its new catalog.  You decide to arrange the document in columns to suit the format of the brochure.  To do this, you first need to change to the Print Layout view because Word formats columns only in this view.  To change to the Print Layout view, you select View – Print Layout.  Then you manually select the body of the first page so that only that page and not the title will appear in columns.  If you want to arrange the entire document in columns, you choose Select All from the Edit menu.  To insert multiple columns, you click the Columns button on the Standard toolbar.  Then you select the number of columns you want, in this case two, by clicking the second column in the drop-down box.  You can also select columns by dragging from the first column to the right until the number of columns you want is selected.  The document is now arranged in two equal columns.  If the Columns button is not on the toolbar, you click the Add or Remove Buttons button in the More Buttons drop-down box on the toolbar and select Columns from the menu.  Word allows you to arrange text in unequal columns.  To do so, you select Format – Columns.  In the Columns dialog box you can choose from a number of column options in the Presets section.  And you can change the column width or the column spacing.  In this case you select the Two box and the layout is displayed in the Preview section of the dialog box.  And you click OK to apply the layout to the document.
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Let's say that you decide to arrange part of your document in three columns.  So you select the text and apply the new layout.  When the new layout is applied to the document, you notice that the text does not fill all three columns.  So you decide to place a section break at the end of the page to place the text in an individually formatted section of its own.  This will cause the text to be reformatted to fill the entire section and it will be spread evenly across the three columns.  To place the text in a section of its own in the document, you place the insertion point at the end of the text.  And you select Insert – Break.   Then you select the Continuous radio button because you do not want the section break to be visible in the document.  The Continuous option in the Insert Break dialog box makes it possible to create a formatting section break halfway down a page without visibly separating the text in the bottom half from the section in the top half of the page.  When you have completed the settings for your section break, you click OK.  And the text is evenly spread across the three columns on the page.  If you want to insert a page break after the section break, you place the insertion point after the section break and you insert a manual page break.  If you decide to remove the columns from a part of the document, you click the section you want to change or you select multiple sections.  Then you click the Column button on the Standard toolbar.  And you select only one column in the drop-down box.  You can also select Format - Columns and select One from the Presets section of the Columns dialog box.  The selected text is returned to a one-column format.

4 OF 5 (1-3 USING COLUMNS) (4-5 MANAGING TEXT FLOW)

Word automatically inserts page breaks in a document as you type.  You can also force page breaks by pressing Ctrl+Enter, which inserts a manual page break.  Sometimes page breaks divide lines or paragraphs inappropriately but you can control this by using specific pagination options.  You can regulate line and page breaks using the options provided on the Line and Page Breaks tabbed page of the Paragraph dialog box.  For example, Word automatically hyphenates words at the end of lines and allocates line numbers but you can suppress these options by selecting the appropriate checkboxes.  You can also select the Keep with next checkbox to keep two lines together or you can select the Page break before checkbox to place a page break in a specific place.  Single lines sometimes appear at the end or the top of a page because they have been separated from the rest of the paragraph by page breaks.  A widow is the last line of a paragraph printed by itself at the top of a page.  An orphan is the first line of a paragraph printed alone at the bottom of a page or column of text.  Let's say that you want to remove a widow line from a document.  You can remove orphan lines from a document in the same way as you remove widow lines.  So you select the paragraph in which it appears.  And you select the Format menu.  From the Format menu you select Paragraph.  You can also right-click anywhere in the document and select Paragraph from the shortcut menu.  And you click the Line and Page Breaks tab in the Paragraph dialog box.  On the Line and Page Breaks tabbed page you select the Widow/Orphan control checkbox and you click OK.  The Widow/Orphan control option is usually selected by default.  The widow line is now placed with the rest of the paragraph in the document.
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When Word paginates a document, lines are sometimes split onto two pages so that they appear in two different paragraphs.  If this happens, you can reformat the page to remove the break.  To remove a break in a line, you first select the paragraphs in which the broken line appears.  And then you select the Format menu.  From the Format menu you select Paragraph.  And you click the Line and Page Breaks tab.  Then you select the Keep lines together checkbox and you click OK.  The line now appears with the paragraph on one page in the document.

END OF COLUMNS

SUMMARY:

You have seen how to use newspaper columns in a Word document.  

Word allows you to format your documents in newspaper style so that they can be used for newsletters or brochures. You are able to determine the number of columns you want to use and the width and spacing of the columns. You can also balance the text in the columns so that all the  columns on a page are of equal length.  You can remove columns to return the document to its original format.  Word inserts automatic page breaks in a document as you type. This means that single lines, called widows or orphans, are sometimes separated from the rest of the paragraph by page breaks. Or lines are sometimes broken by a page break.  Word allows you to format the document to remove widows and orphans as well as unwanted line breaks.

UNIT TEST:

1. Which of the following statements are true of creating newspaper columns in a Word document?

a. Once text is formatted in multiple columns, it cannot be returned to the default format

b. You can divide a document into individually formatted sections

c. You can use columns of equal width only

d. You can balance multiple columns so that the text is spread evenly between them

2. If you want to format a piece of text in a document separately from the rest of the document, you insert a _____.

a. page break

b. new column

c. section break

d. tab

3. Is the following statement true or false?

Windows, orphans, and line breaks may be caused by the automatic page breaks in Word.

a. True

b. False

4. When the first line of a paragraph appears alone at the bottom of a page, it is called _____.

a. a widow

b. an orphan

c. a line break

5. When a single line is broken between two paragraphs, it is called _____.

a. a widow

b. an orphan

c. a line break

ANSWERS:

1. b & d

2. c

3. True

4. b***

5. c***

INTERMEDIATE WORD

ADVANCED FORMATTING OPTIONS

1 OF 11 (1-3 USING AUTOMATED FORMATTING OPTIONS)

Word 2000 provides a number of advanced formatting options including

• the Click and Type feature   for the automatic alignment   of text or graphics

• the AutoCorrect feature to   correct text errors as you type

The Click and Type feature automatically formats the alignment of text, graphics, tables, or other items in a document.  You can insert Click and Type items in most areas of the document, including next to the right-hand margin of a page next to existing text.  You can also add graphics to the end of a piece of text without inserting blank lines because the Click and Type feature automatically spaces the graphic correctly.  You cannot use the Click and Type feature 

• in multiple columns

• in bulleted or numbered lists

• next to text indents

• next to floating objects

• next to pictures that are   formatted with top and bottom   text wrapping

• in the Normal, Outline, or   Print Preview views

To turn on the Click and Type feature, you select Tools - Options.  Then you click the Edit tab.  On the Edit tabbed page you select the Enable click and type checkbox and you click OK.  You can use the Click and Type feature in Print Layout or Web Layout view.  As you move the Click and Type pointer over the document, the pointer shape indicates the format it will use if you double-click a space, for example left-indent.  To insert the item of your choice, you simply double-click the place in the document where you want to insert the item.  For example, if you double-click the center of a blank page, the Click and Type feature will format the text as a centered heading.  When you insert an item below an existing paragraph, the Click and Type feature uses the default paragraph style in that part of the document.  If you want to view the format of an existing Click and Type item, you can check the alignment settings using the Paragraph option on the Format menu.  Or you can use the horizontal ruler to view tab stops and indents.  If you want to change the paragraph style, you select Tools - Options.  And you change the default settings in the Click and type section on the Edit tabbed page.
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Let's say that you are creating a new Word document and you want to use the Click and Type feature to format the first page as a title page.   You want to place the document title in the center of the page.  And you want to add a date to the bottom right-hand corner of the page.  In this case you select View - Print Layout to work in this view.  To place the document title at the center of the blank page, you move the insertion point to the center of the page and double-click.  Then you type the document title, in this case Catalog Distribution Progress Report.  If you want to insert a picture or a table at the center of a blank page instead of text, you double-click and then follow the procedure for inserting a table or a picture.  To add a date to the bottom right-hand corner of the title page, you move the pointer until you see the Right Align icon appear.  Then you double-click the place where you want to place the date and you type it in.  The Click and Type feature allows you to position tables and other objects in your document exactly where you want them.  So you no longer need to insert a table and then move it around to place it where you want it.  To do this, you move the pointer until you see the Click and Type pointer and then you double-click the place where you want the table to appear, in this case inside another table.  To insert a table, you select the Table menu.  And you select Insert - Table.  In the Insert Table dialog box, you use the spin boxes to determine the number of columns and rows you want in the table, in this case 2 columns and 2 rows, and you click OK.  The table then appears where you placed it in the document.
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The AutoCorrect feature corrects typing errors as they occur in a document.  You can customize the AutoCorrect options to correct grammatical errors or spelling as you type.  On the AutoCorrect tabbed page of the AutoCorrect dialog box you can set the feature to correct mistyped words.  Or you can set it to correct text format errors on the AutoFormat As You Type tabbed page.  The AutoText tabbed page can be used to set automatic text styles.  And the Autoformat tabbed page can be used to set page format styles for a document.  To activate the AutoCorrect feature, you select Tools - AutoCorrect.  On the AutoCorrect tabbed page you can select any or all of the checkboxes to activate specific AutoCorrect features.  The first four checkboxes on the AutoCorrect tabbed page ensure that the most common capitalization errors are corrected while you type.  And the Replace text as you type checkbox activates the automatic spelling checker as you type.  The AutoCorrect feature contains an alphabetical list of common spelling errors, which it uses as the default when you select the Replace text as you type checkbox.   When you specify new words in the Replace text box, they are added to the default list.  To add a word to the automatic spelling checker, you type the word, in this case wrnt, in the Replace text box and you type its replacement, in this case went, in the With text box.  You can choose to save an entry with or without its original formatting.To save it with its formatting, you select the Plain text radio button and to save it without the original formatting, you select the Formatted text radio button.  Then you click Add.  When the automatic spelling check is activated, any words that the spelling checker does not recognize, in this case Remmber, are underlined with a wavy red line.   To correct the word, you right-click it and select the correction from the shortcut menu.  You can also select AutoCorrect from the menu and you select the correction from the list.  If there are words that you want the AutoCorrect feature to ignore, you select Tools - AutoCorrect.  And you click the Exceptions button on the AutoCorrect tabbed page.  Then on the Other Corrections tabbed page you type the word, in this case Pilner, in the Don't correct text box and you click Add.  When you have entered the exception, you click OK.  And you click OK again when you are returned to the AutoCorrect tabbed page.

4 OF 11 (4-7 INSERTING GRAPHICS)

Word provides various ways in which you can insert pictures in a document.  These include

• inserting a picture from the   Clip Gallery

• inserting a picture from a file

• scanning a picture and inserting it

• inserting graphics on an envelope

Suppose that you want to insert a picture in a document.  First you click the place on the page where you want to insert the picture.  Then you select Insert - Picture.  You can also click the Insert ClipArt button on the Drawing toolbar and then click the Pictures tab.  If you want to insert one of the default pictures from the Office 2000 Clip Gallery, you select Clip Art from the Picture menu.  In the Insert ClipArt dialog box you can choose to insert a picture, a sound, or a motion clip.  You browse to the category you want and you click it - in this case Sports and Leisure.  To insert a picture, you select it and click the Insert clip button on the menu.  And you close the Insert ClipArt dialog box.  The clip art image now appears in the document and you can move it or resize it as you want it.

5 OF 11

You can insert a picture from a file or you can scan a picture into your document.  Inserting pictures from files significantly increases the size of the document file.  If you want to reduce the size of the file, you can insert the picture by selecting Link to File in the Insert ClipArt dialog box.  Word then displays the picture by accessing the file when the document page is opened.   If you insert a picture using the Link to File option, you cannot edit the picture in the document.  Let's say that you want to insert a picture from a file into a Word document.  First you place the insertion point where you want to insert the picture and then you select the Insert menu.  And you select Picture - From File.  In the Insert Picture dialog box you browse to and select the location of the picture file - in this case the My Pictures folder - from the Look in drop-down list.  And you select the file that contains the picture, in this case Cap003.pcx.  Then you click Insert or you double-click the picture you want to insert.  The picture now appears in the document but the text wrap setting has placed it between the bullet points on the list.  To correct this, you right-click the picture and select Show Picture Toolbar from the list.  Then you click the Text Wrapping button.  You can use the text wrapping function to place the picture in the text, up against it, behind it, in front of it, above and below it, or through it.  In this case you select In Front of Text.  And the picture appears on the page without dividing the bullet points.  You can also position a picture in your document by selecting it and then dragging it to any position in the document.  You can use the Picture toolbar to edit the picture's color or brightness or you can use it to crop the image on the page.  If you decide to delete a picture, you select it and select the Edit menu.  And you choose Clear.  The picture is deleted and the document is restored to its former settings.  You can also delete a picture by selecting it and pressing the Delete key.
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If you want to scan a picture and insert it in your document, you need to ensure that

• a scanner or digital camera is   attached to your computer

• the scanning device is   TWAIN-compatible

• you have installed   TWAIN-compatible   software on your computer

TWAIN (Technology/Toolkit Without An Interesting Name) is a computer interface standard for scanners. Most scanners have a TWAIN driver and are sold with TWAIN-supporting software.  Suppose that you want to insert a scanned picture on the title page of your document.  To begin, you select Insert - Picture - From Scanner or Camera.  If you have more than one device attached to your computer, you need to specify the one you want to use in the Device drop-down list box in the Insert Picture from Scanner or Camera dialog box.  In this case there is only one device attached to your computer so the device identification appears in the Device drop-down list box by default.  If you want to use a lower resolution for the picture or you want the document to be viewed on screen only, you can select the Web Quality radio button.  But if you want a higher resolution picture or you want to print the document, you can select the Print Quality radio button.  In this case theWeb Quality radio button is selected by default because of the default settings on the scanner.  The Insert button may be unavailable if the scanner you are using does not support automatic scanning.  If the scanner allows automatic scanning and you want to use the default scan settings, you click Insert to insert the picture.  Because the Insert button is unavailable, in this case you click the Custom Insert button and follow the instructions that come with the scanner you are using.  You also click the Custom Insert button when you are scanning an image from a digital camera or if you want to change the settings for automatic scanning.  When you are ready to scan the picture, you click Scan.  The image appears in the document and you can then modify it.  This includes using the Picture toolbar to adjust the color, contrast, and brightness of the image. 
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Word allows you to add graphics to envelopes so that you can print a company logo or other graphics.  You can add special text to an envelope using the same procedure as you use to insert graphics.  To insert an envelope into the document, you select Tools - Envelopes and Labels.  You can edit the addresses on the Envelopes tabbed page at this stage, if necessary.  You click the Add to Document button to insert a graphic on a new envelope.  Or you click the Change Document button to insert a graphic on an existing envelope.  And the new or existing envelope is displayed on screen in the Print Layout view.  To add a picture to the envelope, you place the insertion point where you want the picture to appear and you select the Insert menu.  Then you select Picture.  You can use any of the Picture menu options to insert a graphic on an envelope.  In this case you select the From File option so that you can insert your company logo.  In the Insert Picture dialog box you select the file you want, in this case award01.gif, and you click Insert.  When the graphic appears on the document page, you select it.  You can then reposition it or change its size so that it appears exactly as you want it.  You can store a specific graphic in the envelope template so that you do not need to reinsert the graphic every time you want to place it on a new envelope.  To store a graphic, you first select the Insert menu.  Then you select AutoText - New.  In the Create AutoText dialog box you type a name for the new template item, in this case CatalogEnvelope1, and you click OK.  Every time you base an envelope on this template in future, the graphic stored in the template will be printed on the envelope automatically.

8 OF 11 (8-11 THE DRAWING TOOLBAR)

The Drawing toolbar is used in Word to modify pictures or drawing objects that are inserted into the document.  If the Drawing toolbar is not visible, you select View - Toolbars and you select Drawing from the Toolbars submenu.  Pictures can be inserted from clip art, bitmap files, or scanners and are modified by means of the Picture toolbar and a limited number of functions on the Drawing toolbar.  Drawing objects are predefined images and drawing tools including AutoShapes, text boxes, and WordArt.  They can be inserted into a document using the Drawing toolbar or the Insert menu.  Pictures imported from bitmap files and scanners cannot be modified in your Word documents.  This is because they cannot be ungrouped - that is, converted into drawing images - and only limited functions of the Drawing toolbar can be applied to them.  Pictures from the Office 2000 Clip Gallery are in metafile format and so they can be ungrouped in Word documents.   But they first need to be set to the In Front of Text text wrapping option because this separates them from the document text surrounding them.  Once they are ungrouped, they are automatically converted into drawing objects and can be fully modified using the Drawing toolbar.   The Drawing toolbar allows you to place text boxes in a document using the AutoShapes or Text Box buttons.  Text boxes can be in the form of an AutoShape, such as a Callout (or speech bubble), which you may want to use with clip art images.  Or they can be labels of various types or pieces of text that you may want to paste on an existing image.  When you insert a text box into a document, the Text Box toolbar appears.  You can use this toolbar to create hyperlinks from one text box to another or to change the direction of the text in the text box.
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The AutoShapes menu on the Drawing toolbar provides tools to help you draw pictures in a document.  The Lines option on the AutoShapes menu contains a set of drawing tools, including curves, freeform, and scribble.  You can use these tools to draw in the document, for example you select the Freeform option to draw a complex shape without jagged lines.  Or you can select the Curve option if you want to draw a circle or curve.  All Lines AutoShapes are inserted with the In front of text wrapping style.To change the text wrapping style, you use the Text Wrapping submenu on the Drawing toolbar.  Besides the Lines option, the AutoShapes menu contains fixed shapes that you can use to build a graphic on the document page.  For example, you can use the shapes in the Flowchart option to construct a custom flow chart in a document.  To design a flow chart using AutoShapes, you click a shape in the Flowchart submenu and you click the place on the page where you want it to appear.  You can move the AutoShapes by selecting them and then dragging them to the position where you want them to appear.  When you have placed all the shapes where you want them, you click the Line button on the Drawing toolbar.  Then you click a place on the first box and drag to a place on the second box - releasing the mouse button will cause a line to appear.  You can add text boxes to your flow chart to enter information in the cells.  To do this, you click the Text Box button.  Then you click inside a Flowchart shape and a text box appears so that you can add text to the chart.
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You can use the Drawing toolbar to insert decorative text in a document.  To do this, you click the Insert WordArt button.  In the WordArt Gallery dialog box you select the WordArt style you want to use and you click OK.  If you have not selected text to modify, the Edit WordArt Text dialog box appears so that you can enter text - in this case you type Catalog Description.  And if you want to change the size of the text, you click the Size down-pointing arrow and you select a size, in this case 28, from the list.  Then you click OK.  The modified text appears in the document with the WordArt toolbar, which you use to edit the text.  The WordArt toolbar allows you to

• provide alternative text if the text is to be  loaded on a web page

• change the style of the modified text

• format the color, position, and size of the text

You can use the WordArt toolbar to

• change the shape   of the text

• rotate the text on  the page

• change the text   wrapping option

• resize the letters

• make the text  vertical

• realign the text

• space the letters 

Because a WordArt text effect is a drawing object, you can use the Drawing toolbar to edit it.  For example, you can click the Shadow button to place a shadow in the text.  Or you can click the 3-D button to make the text appear three-dimensional.
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You can insert clip art images behind any text, including text in a table, to add effect to your document.  To do this, you place the insertion point on the text and click the Insert Clip Art button on the Drawing toolbar.  Then you click a category, in this case Business, in the Insert ClipArt dialog box.  You select a clip and click the Insert clip button.  The clip appears on the screen but it is covering the text.  So you right-click the clip to access the shortcut menu.  Then from the shortcut menu you select Order - Send to Back.  The clip art image now appears as a background to the text, creating a graphic effect in the document.

END OF ADVANCED FORMATTING OPTIONS

SUMMARY:

You have seen how to use the advanced document formatting options in Word.  

You can use the Click and Type feature to format the alignment of a blank space in a document so that you can insert text, graphics, tables, or other items.  The AutoCorrect feature corrects typing errors as they occur in a document. You can customize the AutoCorrect options to correct grammatical errors or spelling as you type.  There are many different ways in which you can insert images in a Word document. You can insert a picture from the default Clip Gallery provided in Office 2000, you can insert a picture from another file, or you can scan a picture into the document using a scanner or a digital camera. Once you have inserted a picture, you can edit the position and characteristics of the picture or delete it.   Word allows you to insert images on envelopes using all the above techniques.  The Drawing toolbar can be used to insert or modify pictures and text in a document. You can modify clip art images and, to a limited extent, imported pictures using the Drawing toolbar.  You can use the AutoShapes function on the Drawing toolbar to access drawing tools and to draw your own picture or to insert predrawn shapes into your document. And you can insert WordArt text effects into the document and change the text shape, shade and color it, or give it a three-dimensional appearance.  The Drawing toolbar also allows you to add text boxes to a document as part of a flow chart, clip art images, or in combination with AutoShapes.

UNIT TEST:

1. In which of the following places can you use the Click and Type feature in a document?

a. In the right-hand margin of the page

b. At the end of a paragraph

c. Next to floating objects

d. In bulleted lists

2. In which of the following views can the Click and Type feature be used?

a. Normal

b. Outline

c. Print Layout

d. Web Layout

3. Which of the following can be corrected by AutoCorrect?

a. The format of the document text

b. A misspelled word

c. Capitalization errors

d. Numbering errors

4. Which of the following can you set the AutoCorrect feature to do?

a. Open automatically when a word is misspelled

b. Leave certain words uncorrected

c. Correct the formatting of tables

d. Indicate words in the text that are mistyped

5. In which of the following cases can you modify a picture in a document?

a. When you insert a clip art image

b. When you link a page to a picture file

c. When you insert a picture from a scanner

d. When you insert a picture on an envelope

6. Which of the following are true of scanning a picture into a document?

a. You need to use a scanner that is TWAIN-compatible

b. You can scan a picture from a digital camera

c. You can set the picture resolution for screen viewing or printing

d. You need to insert scan settings for your scanner

7. Which of the following statements apply to inserting graphics on envelopes?

a. You can insert graphics on new envelopes only

b. You can create a custom envelope template containing graphics

c. You can scan a picture onto an envelope

d. You insert a graphic in the Print Layout view

8. Which of the following can be fully edited using the Drawing toolbar?

a. Clip art pictures

b. Bitmap pictures

c. Scanned pictures

9. Is the following statement true or false?

You can draw charts using the tools provided in the Drawing toolbar.

a. True

b. False

10. On which of the following can text boxes be placed?

a. Clip art images

b. Imported pictures

c. AutoShapes

d. Blank pages

11. Which of the following statements are true of WordArt?

a. You can use it to create text effects

b. You can apply it to new and existing text

c. You can use it in combination with clip art

d. You can create new WordArt styles

12. If you turn WordArt text so that it is displayed at an angle, you are adjusting its _____.

a. text wrapping

b. alignment

c. rotation

d. shape

13. Which of the following effects can be applied to WordArt?

a. A shadow

b. A three-dimensional view

c. A sound

d. Web viewing options

ANSWERS:

1. a & b***

2. c & d

3. a, b & c***

4. b & d

5. a, c & d***

6. a, b & c***

7. b, c & d***

8. a***

9. True

10. a, c & d***

11. a, b & c

12. c***

13. a, b & d

INTERMEDIATE WORD

DOCUMENT STRUCTURE

1 OF 12 (1-4 TEXT MANIPULATION)

Word 2000 allows you to manipulate the text in your document.  You can alphabetically sort bulleted and numbered lists as well as paragraphs.  And you can sort data stored in rows or columns in a table.  Let's say that you want to sort the text in a bulleted list so that the list is arranged alphabetically from A to Z.  First you select the list you want to sort.  And then you select Sort from the Table menu.  In the Sort by section of the Sort Text dialog box you choose Paragraphs from the drop-down list.  From the Type drop-down list you can choose to sort by text, number, or date - in this case you select the Text option.  And you ensure that the Ascending radio button is selected so that the text is sorted from A to Z.  The My list has section of the dialog box allows you to exclude first rows from being sorted, but you cannot exclude first rows if your selection is a table.  With the Header row radio button selected you can exclude the first row from being sorted with the list.   And with the No header row radio button selected you can sort all rows in the list, including the first row.  Because your bulleted list has no header row, you leave the No header row radio button selected and you click OK to apply the changes.  The bulleted list is now arranged in ascending order.
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Sorting paragraphs can help you organize paragraphs alphabetically - for example to arrange a list of definitions or a bibliography.  To do this, you select the paragraphs you want to sort.  And then you select Table - Sort.  You can see that Word automatically suggests organizing by paragraphs.  You choose to keep the default data type as Text.  And you want the text arranged alphabetically in ascending order so you keep the Ascending radio button selected.  You can click the Options button to set additional sorting criteria, such as case sensitivity, but in this case you need no additional criteria.   So you click OK to apply the sorting.  And the paragraphs are then sorted accordingly.
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Let's say that you have a table in a document and you want to arrange the information in that table.  To sort a table, you click anywhere in one of the table's cells.  Then you select the Table menu.  And you select the Sort menu option.  In the Sort dialog box you see that you can sort by more than one column.  If there are multiple columns in the table, Word uses the first column to sort and if there are entries that are the same it will use the other columns to differentiate them.  Suppose that your table has header rows so you select the Header row radio button.  This automatically places the column headings in the Sort by drop-down list.  In this case you want to sort using the third column because it contains the number of sales, so you select Total from the drop-down list in the Sort by section.  You see that Word reads the column as containing text, so you select the Number option from the Type drop-down list.  And because you want the highest figures displayed at the top of the Sales column, you select the Descending radio button.  In the Then by section you select the Location option from the drop-down list because you want to sort according to the salesperson's location if any totals are the same.  And you choose to keep the default options that specify that the text will be arranged in ascending order.  You choose Salesperson from the drop-down list in the second Then by section to sort according to the name of the salesperson as the third option.  And you choose to keep the default selection for the sorting.  When you have finished specifying your options, you click the OK button.  And the entries in the table are now sorted according to your specifications.
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Word 2000 allows you to align text vertically on a page.  This means that you can position your text at the top, bottom, or middle of a page.  And you can justify the text so that it fits on the whole page.  To set the vertical alignment of text in a document, you select Page Setup from the File menu.  And then you click the Layout tab.  To align the text with the center of the page, you click the Vertical alignment down-pointing arrow and you select Center.  And then you click the OK button.  In Normal view you cannot fully see the change you made to the text's alignment.  So you select File - Print Preview.  And you can see that the text is located in the middle of the page.

5 OF 12 (5-9 HEADERS AND FOOTERS)

Headers and footers are areas above and below the normal text on a page.  Typically, page numbers and section, chapter, or book titles occupy headers and footers, but you can also insert graphics.  Headers and footers always exist on a page but can be viewed only when you work in the Print Layout view.  Once you've created headers and footers, you can modify them.  You can format text in headers and footers in the same way as you format normal text.   For example, you can select fonts, font styles, and sizes, vary paragraph and line spacing, and insert pictures.  Using the Header and Footer toolbar, you can insert AutoText entries - for example when the document was last saved and by whom.  You can insert page numbers by clicking the Insert Page Numbers button.  And you can insert the total number of pages by clicking the Insert Number of Pages button.  The Format Page Number button allows you to choose the page number style - such as lowercase Roman numerals - to apply to your page numbers.  Using the Insert Date and Insert Time buttons, you can also insert the current date and time.  And you can change the page setup and show or hide the text in the document using the Page Setup and the Show/Hide Document Text buttons.  If you want to have identical headers on each page, you click the Same as Previous button.  To navigate between headers and footers, you click the Switch Between Header and Footer button.  And you can click the Show Previous and Show Next buttons when viewing a header to move between the headers on the previous and next pages. 
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You can make headers on odd pages different from headers on even pages.  You can also specify that there be no header or footer for the first page of a document.  Let's say that you want different headers on odd and even pages because you want different information on facing pages.  To do this, you open the header by selecting View - Header and Footer.  You click the Page Setup button on the Header and Footer toolbar.  And you select the Different odd and even checkbox on the Layout tabbed page.  You can have a different first page if, for example, you don't want any header or footer on the first page.  To do this, you select the Different first page checkbox.   If you create large headers and footers, Word dynamically increases the top and bottom page margins to accommodate the contents of the headers and footers.  You can prevent Word from changing the margins by clicking the Margins tab.  And either in the Top or Bottom spin box you type a negative number for the margin width - in this case you type -1 for a one-inch margin - and then you click OK.  To close the Header and Footer view, you click the Close button.  This returns you to the document's normal text.
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You can add pictures and text to headers and footers.  You can also add the current date and time.  And you can add page numbers.  Let's say that you want to add a descriptive title to the top right-hand corner of the first page as well as the current date to the left-hand corner.   To add headers and footers, you select View - Header and Footer.   This opens the header at the top of the page and the Header and Footer toolbar.  The main text of the document is dimmed, which means that you cannot edit the text while in the header or the footer.  As you want the title aligned with the right-hand margin, you double-click the right-hand margin.  You can also click the Right Align button on the Standard toolbar.  And then you type the descriptive title - in this case February Progress Report.  To format your text - for example to bold the title - you first select it.  And then you click the Bold button on the Formatting toolbar.  The text is then formatted.  To add the date and time to the left-hand margin, you double-click the left-hand margin.  Then you select Insert - Date and Time.  This opens the Date and Time dialog box and you can see that there are many different formats available to apply.  You select an option from the list of available formats - in this case you select the 15 February 2000 option.  To make this the default date format, you click the Default button.  And then you click Yes to confirm the change.  The Language drop-down list allows you to choose the language you want to use for the date or time.  And, if you always want the current date or time reflected in the document, the Update automatically checkbox updates the date or time when you print your document.  In this case you don't want the date updated automatically so you do not select the checkbox and you click OK.  The date is then added to the header and you can apply normal text and paragraph formatting to it.
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Let's say that you want to add a watermark - a faint picture that lies behind text - to the header.  And you want to insert a page number next to the left-hand margin of the footer.  To insert a graphic, you select Insert - Picture - From File.  You navigate to the graphic's location, select the file, and click Insert.  And the picture is added to the header.  When you have positioned the graphic on the page, you make it a watermark by clicking the image to activate the Picture toolbar.  You can also select View - Toolbar - Picture or you can right-click any toolbar and select Picture from the shortcut menu.  You click the Image Control button and select the Watermark option.  And the image is made lighter so that text in front of it will not be obscured.  To move to the current page's footer to insert a page number, you click the Switch Between Header and Footer button.  This displays the footer at the bottom of the page.  You then click the Insert Page Number button, which inserts the current page number next to the left-hand margin in the footer.  You can also insert a page number by selecting the Insert - Page Number menu option, which allows you to specify where in a header or footer you want to place the page number. For more information on inserting page numbers, see the CBT Systems course "Microsoft Office 2000: Beginning Word".  You close the header and footer view by clicking the Close button.  And you are then returned to the normal text and you can see the header text grayed out.
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You may need to troubleshoot the headers and footers you add to your documents.  If you cannot see the headers and footers on screen, you need to make sure that you're in the Print Layout view.  Headers and footers can't be seen in the Normal or Web Layout views.  If you save a Word document as a web page, any headers and footers will not be visible and will not print.  However, they are retained and will be displayed if you return to the .doc format of the document.  Sometimes you cannot see the headers and footers on the first page of your document.  If this is true and your document has sections, you select a section or select the multiple sections in which you want the header or footer to appear on the first page.  Then you click the Layout tab in the Page Setup dialog box and clear the Different first page checkbox.  If your headers and footers are missing or have only partially printed, you may have placed them in the nonprinting area of your page.  First you need to check your printer's manual to find out how close to the edge of the paper the printer can print.  Then on the Margins tabbed page of the Page Setup dialog box you check that the value in the From edge spin box is greater than your printer's minimum possible margin.  When you add page numbers or dates and times, Word inserts fields that are automatically updated as the document changes.  Consequently, you may see field codes, such as {PAGE} or {DATE}, instead of the actual page and date.  To switch between the field code and the field result, you press Alt+F9 on the keyboard.  If the information in the fields in a document's headers and footers is not the most current, you can refresh the fields.  To do this, you select the field and press F9 on the keyboard.  And the current date is then displayed.

10 OF 12 (10-12 ENVELOPES AND LABELS)

It is possible to use Word to create and print envelopes and labels.   When you create an envelope, you can specify the size of the envelope.  You can then type an address manually or insert an address from an electronic address book, such as Microsoft Outlook or the Personal Address Book.  Let's say that you want to send a sample copy of the Award Sportswear Catalog to a client so you want to print an envelope.  To configure envelopes and labels, you select Envelopes and Labels from the Tools menu.  In the Envelopes and Labels dialog box you see that you can add addresses for both senders and recipients.  To add a stored address, you click the Address Book button.  You can also type the address directly in the Delivery Address box.  You then select the name of the recipient and you click OK.  The Return Address list box allows you to type a return address or to select one from the Address Book.  If you choose not to supply a return address, you select the Omit checkbox.  In this case you type Award Sportswear's address.  To select envelope sizes and the envelope's print orientation, you click the Options button.  On the Envelope options tabbed page you specify a size for the envelopes.  In this case - because you're sending a catalog - you select the C4 envelope size from the Envelope size drop-down list.  In the If mailed in the USA section you can include a postal numeric encoding technique (POSTNET) bar code on the envelope by selecting the Delivery point barcode checkbox.  If you include the delivery point bar code, the facing identification mark (FIM) courtesy reply mail checkbox is enabled to allow you to mark the front of the envelope for mail presorting.  In the Delivery address and Return address sections you can change the font used by clicking the Font button.  And you can specify the distance of each address from the top and left-hand sides of the envelope using the From left and From top spin boxes.  In this case you choose to accept the default settings.  To specify printing options for envelopes, you click the Printing Options tab in the Envelope Options dialog box.  On the Printing Options tabbed page you see that you can select how the envelope will be fed into the printer.  The Face up and Face down radio buttons let you decide whether your envelope faces up or down in the printer tray.   And the Clockwise rotation checkbox allows you to reverse the direction of an envelope when you feed it into the printer.   Some printers don't support the clockwise rotation option.  The Feed from drop-down list displays the printer trays available to feed the envelope into the printer.  You can click the Reset button if you want to restore the default settings.  But in this case you choose to keep your current settings and you click OK.   You click the Add to Document button to add the envelope to the beginning of the active document.  This allows you to print the envelope at the same time as you print the document.  The button's name will change to Change Document if your document already contains an envelope.  In this case you want to print the envelope immediately so you click the Print button.  Your envelope is now printed.
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Let's say that you want to print labels to affix to envelopes.  To create and print labels, you select Envelopes and Labels from the Tools menu.  And in the Envelopes and Labels dialog box you click the Labels tab.  On the Labels tabbed page you see that you can enter an address or click the Address Book button.  In this case you type the address for the label and you click OK.  In this case the Delivery point barcode checkbox is unavailable because the currently selected label is not wide enough to support the bar code.  So you click the Options button to change the type of label.  In the Label Options dialog box you see the Printer Information section displaying information about the current printer and the printer feed details.  From the Tray drop-down list you can choose the printer tray for your sheets of labels - in this case you select the Manual Paper feed option.  Word automatically selects the option that's best for your current printer.   From the Label products drop-down list you select the size of the label - in this case Avery A4 & A5 sizes.  Then from the Product number list box you select a label type - in this case you select the J8163 - Address option - and you see the label's information displayed in the Label information section.  To see a graphical representation of the label, you click the Details button.  In the Details dialog box you can adjust the label and so create a new, custom label.  But in this case you choose to keep the default settings and you click Cancel to close the dialog box.  The New Label button allows you to create and name a custom label.  In this case you choose to accept the current settings so you click OK.  And you can now select the Delivery point barcode checkbox to include the POSTNET bar code on the label.  The New Document button adds the labels to the beginning of the current document so that you can print them when you print the document.   This button changes its name to Change Document if your document already contains labels.  In the Print section you can choose a full page of the same label or a single label - in this case you choose the Single label radio button.  You then verify that the labels are loaded in the printer's manual feed tray and you click the Print button.  And your labels are now printed.
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You may need to troubleshoot the creation and printing of envelopes and labels.  If the envelopes or labels you are printing are in a printer tray but Word still prompts you for a manual feed, you can try changing the printer tray in the Print dialog box.  You should also ensure that you are using the most up-to-date version of the printer's driver.  And you should confirm that you selected the correct feeding method when you configured the print job.  If the POSTNET bar code option is not available for mailing labels, you should check the size of the label you've selected because the bar code could be too wide for it.  The FIM-A courtesy reply mail checkbox is not available for mailing labels.  But if both the POSTNET bar code and the FIM-A courtesy reply mail options are unavailable, it may be because you have enabled and written in an editing language other than English.

END OF DOCUMENT STRUCTURE

SUMMARY:

You have seen how to change a document's structure.  

It is common to sort information that appears in tables, but with Word 2000 you can also sort paragraphs and bulleted and numbered lists. When you sort text, you can choose to create ascending or descending sorted lists.  You can change the vertical alignment of text on a page. You can choose for the text to be aligned with the top (the default), center, or bottom of the page  or you can justify the text so that it covers the  whole page.  Headers and footers are areas above and below normal text on a page. Page numbers and chapter or book titles occupy headers and footers. But you can also insert graphics into headers, particularly when creating watermarks.  You can format text in headers and footers in the same way as you format normal text. For example, you can select fonts, font styles, and sizes, vary paragraph and line spacing, and insert pictures.  You can modify the distance between the edge of the page and your headers and footers. And you  can have different headers and footers on odd and even pages.  It is possible to use Word to create and print envelopes and labels. You can create addresses for many different sizes of envelope and you can insert addresses from an electronic address book, such as Microsoft Outlook or the Personal Address Book.  POSTNET bar codes and FIM-A codes can be added to envelopes and mailing labels. And you can determine the orientation of envelopes when printing them.

UNIT TEST:

1. When vertically aligning text, you _____ it to make it fit on the whole page.

a. center

b. left-align

c. justify

d. expand

2. You can exclude the top row of a selection from being sorted if your selection is a table.

a. True 

b. False

3. If the field result in a header does not display the most current information, you need to delete the field and insert it again.

a. True

b. False

4. Headers and footers can be seenin the _____ view.

a. Web Layout

b. Normal

c. Print Layout

d. Outline

5. Can you add a sender's address to an envelope as well as a recipient's address?

a. Yes

b. No

6. Which of the following can you do when specifying an address on an envelope?

a. Add a graphic

b. Specify the distance of the address from the left-hand side

c. Specify the distance of the address from the top of the envelope

d. Choose the font size

ANSWERS:

1. c

2. False***

3. False

4. c

5. Yes

6. b, c & d

COURSE TEST:

1. To get the Format Painter to apply text formatting to one item of text and then automatically turn off, you _____ the Format Painter button and to apply text formatting to more than one item without reactivating the Format Painter, you _____ the Format Painter button.

a. double-click

b. click

2. Which of the following are true of styles in Word?

a. There are a range of predefined styles available in Word

b. Predefined styles in Word cannot be modified

c. You can create and save new styles in Word

d. You can modify a style as you change text formatting in your document if you have activated the automatic update feature

3. From which of the following can themes be imported into Word?

a. FrontPage 2000

b. The Office web site

c. PowerPoint 2000

d. Outlook 2000

4. To which of the following can you apply themes in Word?

a. FrontPage documents

b. E-mail messages

c. Excel documents

d. Web pages

5. If you want to format a piece of text in a document separately from the rest of the document, you insert a _____.

a. page break

b. new column

c. section break

d. tab

6. When a single line is broken between two paragraphs, it is called _____.

a. a widow

b. an orphan

c. a line break

7. In which of the following views can the Click and Type feature be used?

a. Normal

b. Outline

c. Print Layout

d. Web Layout

8. Which of the following can be corrected by AutoCorrect?

a. The format of the document text

b. A misspelled word

c. Capitalization errors

d. Numbering errors

9. Which of the following statements apply to inserting graphics on envelopes?

a. You can insert graphics on new envelopes only

b. You can create a custom envelope template containing graphics

c. You can scan a picture onto an envelope

d. You insert a graphic in the Print Layout view

10. If you turn WordArt text so that it is displayed at an angle, you are adjusting its _____.

a. text wrapping

b. alignment

c. rotation

d. shape

11. Is the following statement true or false?

You can draw charts using the tools provided in the Drawing toolbar.

a. True

b. False

12. On which of the following can text boxes be placed?

a. Clip art images

b. Imported pictures

c. AutoShapes

d. Blank pages

13. You can exclude the top row of a selection from being sorted if your selection is a table.

a. True

b. False

14. Headers and footers can be seen in the _____ view.

a. Web Layout

b. Normal

c. Print Layout

d. Outline

15. Can you add a sender's address to an envelope as well as a recipient's address?

a. Yes

b. No

ANSWERS:

1. 1st blank: click, 2nd blank: double-click

2. a, c & d

3. a & b

4. a, b & d

5. c

6. c

7. c & d

8. a, b & c

9. b, c & d

10. c

11. True

12. a, c & d

13. False

14. c

15. Yes

